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CHAPTERS 1, 2, AND 3 – MICROSOFT POWERPOINT 2013 
IN COMMAND OF COMMANDS 

 
 
Start PowerPoint | Select Document Theme and Variant | Select a Custom Font Size | Change Text 
Color | Add Additional Slides | Insert Text Slide with Multilevel Bulleted List | Duplicate a Slide | 
Change Theme and Variant | Add Chart | Add New Slide icon to Quick Access Tool Bar | Move 
Between Slides in Normal View | Save Presentation | Insert Picture from Office.com on Title Slide | 
Size and Move an Image | View in Different Views | Add Transition Effects | View Slideshow View | 
Add a Textured Background | Add a Picture Background | Add and Format a Shape | Insert WordArt | 
Add Animation Effects | Insert Notes Pages | Add Comment | Add a Header or Footer | Insert a Video 
File | Insert Multiple Images | Add Audio to a Slide | Add Sound from the Gallery | Record an Audio 
Clip | Add Web Hyperlink | Insert a Hyperlink to Slide | Insert Action Buttons | Insert a Hyperlink to a 
File | Play Background Music | Set Slide Timings | Print | Set Up Show | Present the Show | Add 
Slides from Other PP Presentations  
 

 
 

Objective 
 

 
How do I do it? 

 
Start 
PowerPoint 

 
1. Click the Start icon on the Task Bar. 

 

 
 

2. Select All Programs… 
 

 
 

3. Click Microsoft Office 2013. 
 

 
 

4. From the Microsoft Office 2013 submenu, select 
PowerPoint 2013. 
 

 
 
 
 
 

Select 
Document 
Theme and 
Variant 

 
1. From the PowerPoint “splash” screen click a theme to display a theme 

preview or click Blank Presentation and add a theme later. 
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2. In the Preview window, click the  arrows to view 
different layouts with the theme applied. 
 

3. Click a variant to view a preview of that style applied to the thumbnail. 
 

 
 
The preview changes to display the new variant. 
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4. Click the Create icon. 
 

 
 
The screen displays a blank presentation with a Title Slide Layout in Slide 
View and a thumbnail in Thumbnail View. 
 

 
 
The default name “Presentation1” displays in the Title Bar. 
 

 
Create a Title 
Slide 
 

 
1. Click in the Click to add title placeholder and type 

[Your Elementary School] – replacing with name of your school. 
 
DO NOT PRESS THE ENTER KEY. 
 

2. Click in the Click to add subtitle placeholder and type 
by [Your Name] – replacing with your name 
 
DO NOT PRESS THE ENTER KEY. 
 

Slide View 

Thumbnail View 
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Select a 
Custom Font 
Size 
 

 
1. Highlight the text [Your Name]. 

 
Click the Font Size down arrow in the Font group and move the mouse pointer 
over a size. 
 
Live Preview will display the selected text with the new font size.  Click to apply 
the selected font size. 
 
OR 
 
Click the Increase or Decrease Font Size icon in the Font Group to change the 
font size by 4 points. 
 
 
 

 
 

Note:  With text highlighted, hold down the Ctrl key and click the [or] 

respectively to increase or decrease the font size. 
 

 
Change Text 
Color 
 

 
1. Highlight text [Your Name] and click the Font Color down arrow in the Font group. 

 

Increase font size Decrease font size 
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Additional colors are available at the More Colors… option. 
 

 
Add 
Additional 
Slides 
 

 

1. From the tab on the Ribbon, click the New 
Slide down arrow in the Slides group to display a 
gallery of slide layouts available with the selected 
theme. 
 

2. Click the desired layout.  
 
 

 
Insert Text 
Slide with 
Multilevel 
Bulleted List 
 

 
1. Click the Title and Content layout. 

 

 
 
The Title and Content layout is a bulleted layout with 
default bullets that complement the selected theme. 
 
A graphic “insert” menu displays in the body of the 
slide, making it easy to insert tables, charts, SmartArt 
graphics, pictures, clipart, and media clips. 
 

2. Click the Click to add title placeholder and type 
 
[Students Grades 1&2] 
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3. Click the Click to add text  placeholder and type [Grade 
1] and press the Enter key. 
 

4. Click the Increase List Level icon in the Paragraph group 
to indent the second-level topic. 
 

 
 
Type [Girls] and press the Tab key twice and type [10].  Press the Enter key. 
Type [Boys] and press the Tab key twice and type [[12]. Press the Enter key. 
 

5. Click the Decrease List Level icon in the Paragraph group to return to the left 
margin. 
 

 
 

6. Type [Total] and tab twice and type 22.  Press the Enter key. 
 

7. Complete Slide 2 as shown below: 
 

 
 

Note:  You may also use the Tab key to perform the same function as the Increase 
List Level icon and the Shift+Tab key to perform the same function as the 
Decrease List Level icon. 
 

 
Duplicate a 
Slide 
 

 
1. With the slide selected in the Thumbnail Pane, right click Slide 2 and select 

Duplicate Slide. 
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2. Complete the slide as shown below: 
 
 
  

 
Change 
Theme and 
Variant 
 

 

1. Click the tab on the Ribbon. 
 

2. Click the More down arrow in the Themes group to display a gallery of available 
themes. 
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As you move your mouse pointer over a design theme, the name of the theme 
displays in a screen tip and the current slide displays with the theme. 
 
3. Select the Berlin theme. 

 

 
 
The Berlin theme is applied to all slides in the presentation. 
 

4. Click the Variant down arrow and select a variant. 
 

 
 
The Green variant is applied to the Berlin theme. 
 

 
 

 
Add Chart 
 

 

1. From the tab on the Ribbon, click the Slide down arrow 
and select a Title and Content layout.  
 

2. Click the Insert Chart icon in the graphic “insert” menu. 
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3. At the Insert Chart dialog box, select a Chart Type and a Chart Style. 
 

 
 
A preview of the selected chart displays: 
 

 
4. Click the OK button. 

 
A sample Excel Spreadsheet displays with sample data and the Chart slide 
graphically displays the sample data. 
 

 
 

5. To increase or decrease the size of the selected area of the spreadsheet, place 
your cursor in the bottom right sizing handle until it turns to a double-pointed 
arrow and the click and drag. 
 
You need five columns and three rows to display your Student data. 
 

 
 

6. Delete the data outside the selected area. 
 

7. Enter the data as shown below: 
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Notice the sample data in the chart change as you add “real” data. 
 

 
8. Click the Click to add title placeholder and type [Student Chart]  

 
9. Click the Chart Title placeholder and type [Students in Grades 1-4] 

 
 
 
Notice the Style options icons at the right of the of chart when it is selected. 
 

10. Click the Close icon on the sample spreadsheet to close it. 
 

Note: Right click the chart and select Edit Chart to make changes to the chart 
data. 
 

 
Add New 
Slide icon to 
Quick Access 
Tool Bar 
 

 

1. Click the tab on the Ribbon. 
 

2. Right click the New Slide icon in the Slides group and select Add to Quick Access 
Tool Bar. 
 

 
 

 
Move 
Between 

 
1. Click the thumbnail in the Thumbnails Pane. 

 
If all thumbnails are not visible, click the vertical scroll bar to the right of the 

Style Options 
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Slides in 
Normal View 
 

Thumbnail Pane. 
 
OR 
 
Click the Vertical Scrollbar to the right of the Slide Pane and drag.   
 

 
 
A tooltip displays the title of the active slide.   
 
Release the mouse to move to that slide. 
 

 
Save 
Presentation 
 

 
1. Click the Save icon in the Quick Access Toolbar. 

 

 
 

2. Save the presentation in the PowerPoint folder as [Name of your Elementary 
School] 
 

Save soon and save often! 
 

 
Insert Picture 
from 
Office.com 
on Title Slide 
 

 
1. Make Slide 1 the active slide. 

 

2. Click the tab on the Ribbon. 
 

3. Click the Online Pictures icon in the Images group. 
 

 
 

4. At the Insert Pictures dialog box, click in the Office.com Clip Art text box and type 
a general category of image [school] 
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and click the Search icon. 
 
There are over a thousand search results for school.  Scroll through the gallery 
and select an image to add to your title slide and click the Insert button. 
 

 
 
The image is added to the slide. 
 

 
 

 
Size and 
Move an 
Image 
 

 
To size a graphic proportionately… 
 

1. Click in a corner sizing handle (bottom right) until the cursor changes to a double-
pointed arrow.  Click and drag up and to the left to make the image smaller and 
down and to the right to make the image larger. 
 

 
 

2. Place the cursor inside the image until the cursor changes to a quad arrow and 
drag to position the image. 
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View in 
Different 
Views 
 

 
PowerPoint has four different views on the Views Bar located on the Status Bar. 

 
 
 

 
 
 

 
Normal View is the default view that displays slide view and thumbnail view. 
 
Slide Sorter View displays a thumbnail version of each slide in the presentation.  This 
is a great way to reorganize your slides – just click and drag them to a new location or 
delete a slide you no longer want. 
 

 
 
Reading View is a way to present the slideshow if you are not using a “big screen” or 
dual monitors. 
 
SlideShow View is used to present the slideshow to your audience.  The slide displays 
in a full-screen view just the way it will look when presented on a “big screen.” 
 

 
Add 
Transition 
Effects 
 

 
Transition refers to the way you advance from one slide to the next.  Transition effects 
can be added to all slides or to selected slides. 
 
With the slides displaying in Normal View… 
 

Normal View 

Slide Sorter View 

Reading View 

Slide Show View 
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1. Click the Slide in the Thumbnail Pane to which you want to apply a transition 
effect.  If you plan to apply the transition effect to all slides, it doesn’t matter 
which slide you select. 
 

2. Click the tab on the Ribbon. 
 

3. Click the More down arrow in the Transition to this Slide group to display three  
categories of transition effects: 
 

 
 
Initially no transition effects are applied to the slides because the None icon is 
selected by default. 
 

 
 

4. Select a transition. 
 
The slide will preview the selected transition. 
 

5. Click the Duration up/down arrow in the Timings group to to increase/decrease 
the transition speed. 
 

 
 

6. To preview the transition, click the Preview icon in the Preview group. 
 

 
 

7. Click the Apply To All option in the Timing group to apply the transition to all 
slides in the presentation. 
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Note:  Transition could also be applied in Slide Sorter View if you want to apply 
different transitions to different slides --  i.e. one transition for all even slides and 
one transition for all odd slides. 
 

 
View in 
Slideshow 
View  
 

 

1. Click the tab on the Ribbon. 
 

2. Click the From Beginning icon in the Start Slide Show group. 
 

 
 

3. Click to advance each slide. 
 

Note:  You will set slide timings later. 
 

 
Add a 
Textured 
Background 
 

1. In the Thumbnail Pane, right click Slide 2 
and select Format Background.   
 

 
 

2. In the Format Background pane that displays 
to the right of the slide, select the Picture or 
Texture Fill option. 
 

3. Cick the Texture down arrow and select a 
texture. 
 
Notice the icon at the bottom of the pane that 
would apply the texture to all slides.  DO 
NOT select this option. 
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Add a Picture 
Background 
 

 
1. In the Thumbnail Pane, right click Slide 3 and select 

Format Background.  
 

 
 

2. In the Format Background pane that displays to the 
right of the slide, select the Picture of Texture Fill 
optiion. 
 

3. Under Insert picture from, click the Online button. 
 

4. At the Insert Pictues screen type a category of picture in the Office.com Clip Art 
text box and click the Search icon. 
 

 
 

5. Select an image from the search results and click the Insert button. 
 

 
 
The image is inserted in the slide, but ‘waaaaaay’ to dark.   
 

6. In the Format Background pane, drag the transparency slider to the right to fade 
the image. 
 

 
  
  

 
Add and 
Format a 
Shape 
 

 
1. Click the the last slide in the presentation and add a New Slide with a Title and 

Content Layout. 
 

 

Transparency Slider 
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2. Click the Click to add title  placeholder and type [3rd 
Grade Art Class]. 
 

3. Click in the body content and type the activities at the 
right: 
 

4. Click the tab on the Ribbon. 
 

5. Click the Shapes down arrow in the Illustrations group and select a shape.   
 

 
 
With the cursor in the shape of a white plus sign, click 
on the slide and drag to draw the shape on the slide. 
 
Size using the sizing handles. Click on the image and drag to position. 
 
Notice the circle at the top of the image.  Position your cursor on the circle and 
drag to rotate the image. 
 

 
Insert 
WordArt 
 

 
With the 3rd Grade Art Class slide active… 
 

1. Click the tab on the Ribbon. 
 

2. Click the WordArt down arrow in the Text group and select a WordArt shape. 
 

 
 

Rotate 
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3. Select the Text in the WordArt placeholder and type [Be Art Smart]. 
 
 
Drag to position to WordArt below the bulleted list. 
 

 
 

4. With the WordArt object selected, click the Text Effects down 
arrow in the WordArt Styles group and select Transform. 
 

5. Move your mouse over a transformation effect in the list and 
watch Live Preview display that effect on the WordArt on the slide. 
 
Click to apply the effect. 
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Add 
Animation 
Effects 
 

 
Animation effects refer to the way each 
individual object in a slide displays.  
 
Individual objects on a slide can be animated 
in four states;  Entrance, Emphasis, Exit, and 
Motion Paths. 
 
With Slide 1 active… 
 

1. Click the Title [Your Elementary School]. 
 

2. Click the tab on the Ribbon. 
 

3. Click the Animation Pane icon in the 
Advanced Animation group to display an 
Animation Pane at the right of the Slide 
View. 
 

4. There are several ways to add 
animation effects. 
 
Click the Add Animation down arrow in 
the Advanced Animation group to 
display Entrance, Emphasis, and Exit 
effects that can be added to a selected 
object. 
 

5. Click an Entrance effect and the slide 
will preview the effect. 
 
Select More Entrance Effects…  to 
display additional Entrance Effects in a  
popup window that will preview the effect 
on the slide as you select it. 
 

 
 

Note:  If the effect is not previewed, be sure 
the Preview Effect option is checked. 
 

6. Click the OK button to apply the selected 
effect to the currently selected object. 
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Note:  Notice that some effects are applied to the entire object while others are 
applied to individual characters. 
 

The object animation displays in the Animations Pane with a number to the left 
 

 
 
A corresponding number displays beside the animated object in the slide. 
 

 
 

7.  Click the subtitle object on the slide and select an Entrance effect. 
 

 
 

 
 

8. In the Animation Pane, click the Play From button to preview the effect of the 
selected object. 
 

  
 

9. Click the Preview icon in the tab to preview ALL of the animations 
on the active slide. 
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10.  To reorder the animation effects on a slide, select slide and click the up or down 
arrow in the Animation Pane to move it. 
 

 
 

11. Click the Close icon in the Animation Pane. 
 

 
Insert Notes 
Pages 
 

 
A Notes Page is notes that the speaker types on each page that can be used as a guide 
during a presentation.   
 

1.  Click the  icon on the Status bar 
 
or 
 

Click the tab on the Ribbon and click the Notes icon 
in the Show group to display a Click to add notes pane 
below the active slide. 
 

 
 

2. Click on the horizontal rule until the cursor changes to a double-pointed arrow 
and drag up to expand the Click to add notes pane. 
 

3. Type a Notes Page on Slide 1 that briefly describes your elementary school. 
 

Horizontal Rule 
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4. Click the  icon again to close the Click to add notes  pane. 
 
Note:  The Notes Page can be printed at the bottom of each slide for the speaker 
to use during the presentation. 
 

 
Add a 
Comment 
 

 
Comments are a great way to provide feedback when a group is collaborating on a 
slideshow presentation. 
 

1. Open the slide on which you want to comment in Normal View. (Slide 3) 
 

2. Click at the position in the slide where you would like the comment to appear. 
 

3. Click the  icon on the Status Bar 
 
OR 
 

Click the tab on the Ribbon and click the New Comment icon in the 
Comments group to display a Comment Pane to the right of the active slide. 
 

 
 
 

4. Click the New button in the Comments Pane and type a comment. 
 

 
 
A comment “bubble” displays on the slide.  You can move the comment bubble 
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by clicking and dragging the bubble shape to any location. 
 

 
 

5. Click the Close icon to close the Comments pane. 
 

6. Click the Bubble shape on the slide to reopen the Comments pane and read or 
reply to the comment. 
 

7. To delete a comment, click the comment to select it and press Delete on the 
keyboard. 
 

Note:  To delete all comments on a slide or all comments in a presentation, click the 

 tab on the Ribbon and click the Delete icon down arrow in the Comments 
group and select Delete All Comments and Ink on This Slide or Delete All Comments 
and Ink in This Presentation. 
 

 
 

 
Add a 
Header or 
Footer 
 

 
A Header displays at the top of each Notes Page or Handout. 
A Footer displays on each Slide, Notes Page, or Handout. 
 

1. Click the tab on the Ribbon. 
 

2. Click the Header & Footer icon in the Text group. 
 

Comment Bubble 
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3. At the Header and Footer dialog box, click the tab (Slide or Notes and Handouts) 
to which you want to apply a header or footer. 
 

 
 

4. Select the desired options and click the Apply to All button. 
 

 
 
 
The Update automatically option under Date and Time displays the current date 
when the slideshow is opened. 
 

Note:  The Don’t show on title slide option is often selected to leave the Title slide 
footer blank. 
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Note:  The position of the selected elements depends on the template selected. 
 

 
Insert a 
Video File 
 

 
PowerPoint 2013 supports a number of video formats: 
 
IF YOU ARE CONCERNED WITH DOWNLOADING FILES FROM THE INTERNET 
BECAUSE THEY SOMETIMES HAVE VIRUSES – YOU CAN DISREGARD THIS 
PART. 
 

 
 
The challenge is finding a video that you can download from the Internet that is in the 
Public Domain (which means that it has no copyright restrictions).   
 

In a Google search, type   and click 
the Search button. 
 

Footer text 

Current Date 

Page Number 
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Note:  Because I had problem inserting a YouTube video, I selected  
 

 
 
Because our chart shows that PP will play an MP4 Video file, I selected the smallest 
size. 
 

 
 
 

1.  Right click the link and select Save Link As… 
 

 
 
Note:  This may be “Save Target As… in a different browser. 
 

2. At the Save as dialog box, save the file in the PowerPoint folder with the default 
name. 
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3. Click the Save icon. 
 
The file is saved as 
 

 
 
 
INSERTING THE VIDEO IN THE POWERPOINT PRESENTATION 
 

1. Open slide on which you want to insert the video clip (Slide 2). 
 

2. Click the tab on the Ribbon. 
 

3. Click the Video icon down arrow in the Media group an select Video on My PC… 
 

 
 

4. Navigate to the location of the video clip (PowerPoint folder). 
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5. Select the file and click the Insert button. 
 
A video displays in the center of the current slide.  Drag to postion the video. 
Click on the video to display the options bar. 
 

 
 

6. Click the Play/Pause button to play the video. 
 

 
 

To change the start or end times for the video, you will use the “trim” feature. 
 

7. From the Video tools contextual menu on the Ribbon, click the Playback tab to 
display video playback options. 
 

Options Bar 
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8. Click the Trim Video down arrow in the Editing group. 
 

 
 
Use the sliders or type the Start Time and End Time in the text boxes.  Click the 
OK button. 
 

Note:  Notice the additional options available. 
 

 
Insert 
Multiple 
Images 
 

 
1. Click on the last slide in the presentation and add a new slide with a Two Content 

Layout. 
 

2. Type 2ND  Grade Math Class in the Click to add title placeholder 
 

3. In the right content placeholder, click the Online Pictures icon from the graphic 
insert menu. 
 

 
 

4. At the Insert Picture dialog box, type math in the Office.com Clip Art text box and 
click the search icon. 
 

 
 
Search results for math display. 
 

5. Click the first image you want to insert in the presentation. 
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and scroll to find a second image. 
 

 
Hold down the Ctrl key and click the second image. 
 
Click the Insert button. 
 
Both images display on the the 2nd Grade Math Class slide: 
 

 
 

6. Right click on the slide and select Guides and Gridlines, which will help you 
position the images on the slide. 
 

 
 
Small dotted squares display on the slide. 
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7. Using the Guides and Gridlines, drag the images to position and size using sizing 
handles. 
 
Notice the Smart Guide that lets you know when the images are aligned. 
 
If you want to be sure the images are approximately the same size, click an 

image and click the  option under Picture Tools and check the 
Height: and Width: in the Size group. 
 

8. This is great except the colors of the two images don’t match very well. 
 
Hold down the Ctrl key and click each of the images. 
 

Click the tab on the Ribbon. 
 
Click the Color down arrow in the Adjust group and select Lime, Accent color 1 
Dark. 
 

 
 
 
The background of the images changes to the selected color. 
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Add Audio to 
a Slide 
 

 
Audio clips can be added to a slide in four ways: 

o Sound from the sound gallery 
o Sound from the online clipart 
o Sound from a file 
o Record audio 

 

 
Add Sound 
from the 
Sound 
Gallery 
 

 
With the last slide selected… 
 

1. Add a new slide with a Title only layout. 
 

2. Click in the Click to add title placeholder and type   
 
Thank you! 
 

3. Click the Title Placeholder and move to the center of the screen. 
 

4. Click the Thank you! object and click the  tab 
on the Ribbon.  Add an Entrance effect. 
 

5. Click the Animation Pane icon in the Advanced Animation 
group to display the Animation Pane. 
 

6. Click the title1: Thank you… down arrow and select Effect 
Options… 
 

7. At the dialog box, click the Sound down arrow in the 
Enhancements section and select a sound. 
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8. Click the OK button.  The preview animates the object and plays the sound. 
 

 
Record an 
Audio Clip 
 

 
Recording an audio clip requires that you have a built in microphone or a plug-in 
microphone.  With the slide on which you want to insert the audio clip open in Normal 
View… (Slide 1) 
 

1. Click the tab on the Ribbon. 
 

2. Click the Audio down arrow in the Media group and select 
Record Audio… 
 
The Record Sound dialog box displays. 
 

3. Type a name for your Recorded Sound [Intro] and click the Record button. 
 

 

 
 
 

4. Record your voice with your message – [I hope you enjoy this short presentation 
about My Elementary School] 
 

5. Click the Stop button. 
 

6. Click the OK button. 
 

A sound icon  displays on the screen with an identifying tag  .  Click the sound 
icon. 
 

 
 

7. Click the Play button. 
 

Start Recording 

Stop Recording 

Play Recording 
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8. From the Animations tab, click the Animation Pane icon in the Advanced 
Animation group to display the Animation Pane. 
 
The recorded audio displays below the content objects. 
 

 
 

9. Click the Recorded Sound down arrow and select Effect Options. 
 

 
 

10. At the Play Audio dialog box, click the Timing tab. 
 

 
 

11.  Click the Trigger down arrow and select “Animate as part of click sequence” and 
click the OK button. 
 

 
 

12. From the Animations tab, click the Preview icon in the Preview group to play the 
first slide. 
 
Since you have already animated the Title and Subtitle and attached the sound to 
the Subtitle, the content should animate and the audio should play. 
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Add Web 
Hyperlink 
 

Hyperlinks are text or graphics that when clicked take you to a Web page, another slide, 
or a saved file. 
 
A link to the Internet resources that you used in your presentation is a good example of 
a Web hyperlink. 
 

1. Insert a new slide with the Title and Content layout BEFORE the closing slide. 
 

2. Click the Click to add title placeholder and type [Sources] 
 

3. In the Click to add text  placeholder, type the link text to a resource [Video 
Source]  

4. Highlight the link text and click the tab on the 
Ribbon.   
 

5. Click the Hyperlink icon in the Links group.  
 

6. At the Insert Hyperlink dialog box, click Existing File or Web page and in the 
Address: text box, type or paste the Web address (including the http://) and press 
the OK button. 
 

 
 
The Link Text changes color and is underlined to identify it as a hyperlink. 

 
Note:  The link does not work until you play the Slideshow.  Click the Slideshow icon

  in the Views Bar.  When the Slide displays, click the  
link.   
 
You will be hyperlinked to that Web address on the Internet. 
  

 
Insert a 
Hyperlink to 
Slide 
 

 
Depending on the type of presentation, you may not want to play the presentation in a 
linear fashion but have a Table of Contents with links to slide titles. 
 

1. Click on Slide 1 and insert a new slide with a Two Content Layout. 
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2. Click in the Click to add title layout and type [Table of Contents]. 
 

3. Click in the Click to add text placeholder and type the titles of each of the slides in 
the right and left placeholders. 
 
Students Grades 1&2   Students Grades 3&4 
Student Chart    3rd Grade Art Class 
2nd Grade Math Class   Sources 
 

 
 

4. As an example, highlight the 3rd Grade Art Class text and click 

the tab on the Ribbon.   
 

5. Click the Hyperlink icon in the Links group. 
 

6. In the Link to: pane, click the Place in This Document icon.  
 

7. Select the Slide Title – 3rd Grade Art Class 
 

8. Click the OK button. 
 

The  becomes a  
hyperlink to Slide 6.  
  
Play the slideshow and click the hyperlink.  
 

9. Now you will want to create a hyperlink back to the Table of Contents.   
 

 
Insert Action 
Buttons 
 

 
Action buttons provide a way return to a previous slide (such as the Table of Contents). 
 
With Slide 6 (3rd Grade Art Class) open in Normal View… 
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1. Click the tab on the Ribbon. 
 

2. Click the Shapes down arrow in the Illustrations group. 
 

3. From the Action Button category, click the Back or 
Previous icon 
 

 
 
As you move your mouse pointer over an icon, a tool tip displays the name. 
 

4. With the cursor in the shape of a small, black plus sign, click and drag to draw a 
rectangle shape on the slide where you want the back button to display. 
 

 
 

5. At the Action Settings dialog box, click the 
Hyperlink to: down arrow and select Last Slide 
Viewed.  
 

6.  Click the OK button. 
 

7. Click on the Table of Contents slide and play the 
slideshow.  Click the 3rd Grade Art Class link to 
move to that slide. 
 
Click the Back/Previous icon to return to the 
Table of Contents. 
 

8. Click the Esc key on the keyboard to exit the slideshow. 
 

 
Insert a 
Hyperlink to a 
File 
 

 
Perhaps you already have a report created in Word or a spreadsheet created in Excel 
that you would like to show the audience during the presentation.   
 
For now, let’s just create a Word document for our demonstration: 
 

1. Open Microsoft Word and type [Additional Information about my elementary 
school.] 
 

2. Save the file in the same folder as the PowerPoint presentation with the name 
“Word File”. 
 

3. Close the Word file. 
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Now to link to the file…. 
 

1. Naviagate to the Sources slide in the PowerPoint Presentation. 
 

2. Below the first link, insert the text [My Elementary School]  
 

3. Highlight the text. 
 

4. From the Insert tab, click the Hyperlink icon and in the Link to: pane, 
click Existing File or Web Page. 
 

5. Select the filename and click the OK button. 
 
The My Elementary School text becomes a hyperlink. 
 

6. Play the slideshow and click the My Elementary School link. 
 
The Word® document opens in a new window. 
 

 
 

7. Close the Word® document to return to the PP presentation. 
 

 
Play 
Background 
Music 
 
 

 
AGAIN MP3 FILES CAN ALSO CONTAIN VIRUSES – DO NOT DOWNLOAD THIS 
UNLESS YOU YOU ARE CONFIDENT YOUR VIRUS PRODUCT IS ADEQUATE. 
 
Let’s find some music that we can play in the background through out the entire 
presentation.  How about “Little Red School House” – that seems appropriate.  I 
searched for “Little Red School House video clip download” since I already knew that it 
was in the public domain. 
 

1. Type  http://www.mp3olimp.net/in-the-little-red-school-house/ in the Address Bar. 
 

2. Right click the Download link and save in the PowerPoint folder. 
 

http://www.mp3olimp.net/in-the-little-red-school-house/
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To add the background music… 
 

1. Since you already have a video clip on Slide 3, let’s start the background music 
on Slide 4. 
 
Open Slide 4 in Normal View. 
 

2. Click the tab on the Ribbon. 
 

3. Click the Audio down arrow in the Media group and select Audio on My PC… 
 

 
 

4. Select  and click the 
Insert button. 
 

5. A  displays in the center of the slide indicating that an audio clip has 
been inserted. 
 

6. Select the sound icon and click the  tab to displays options 
for playing the media file. 
 

7. Click the Play in Background icon in the Audio Styles group. 
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8. Click the Slideshow icon  in the Views Bar or click the 

tab on the Ribbon and click the From Beginning icon in the Start 
Slideshow group to play the presentation.   
 

 
 

9. Click through each of the slides.  The background music should play through all 
of the slides. 
 
Since you already have an applause clip on Slide 9 (Thank you), let’s change the 
Effect options so the ‘Little Red School House’ stops at the end of Slide 8. 
 

10. With Slide 2 open in Normal View… 
 

Click the tab on the Ribbon. 
 

11. Click the Animation Pane icon in the Advanced Animation group to open the 
Animation Pane. 
 

12. Click media link down arrow and select Effect Options.  
 

13. At the Play Audio dialog box, with the Effect tab active, 
change the Stop playing After: option to 5 (Slides 4-8) 
and click the OK button. 
 

 
 

14.  Click the sound icon and click the Playback tab from Audio Tools and click the 
checkbox to the left of Hide During Show. 
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15. Now play the entire presentation.  The background music should begin on Slide 4 
and play through Slide 8.   
 

 
Set Slide 
Timings 
 

 
Well, that was fun!  Now let’s see if we can time this so we can play the entire song in 
the background as set the Slide Timings so the presentation will play automatically 
without clicking individually through each object and each slide.  We know that the song 
is about 3 minute and 52 seconds long.  We’ll probably want to leave it for a bit on Slide 
4, because it is a ‘Little Red School House’ and usually you leave a slide displaying 
longer on a chart so the audience can visualize the data. 
 
Note:  Please save the PowerPoint presentation before continuing. 
 

1. Open Slide 1 in Normal View. 
 

2. Click the tab on the Ribbon. 
 

3. Click the Rehearse Timings icon in the Setup group. 
 

 
 
Please note:  Unless the video has been trimmed, this takes quite a bit of memory 
and may cause PP to crash. 
 
4. Click through the presentation at the speed in which you want to present it to the 

audience.  As your rehearse your presentation, a timer at the top left of the 
screen will record the time spent on each slide.   
 

 
 
Once you have the timings the way you want them, you can save them and use 
them to run your slide show automatically. 
 

5. As I try to match up the music and the slides, I find that it would be better to have 
the 2nd Grade Math Class after the Students in Grades 3&4, so the music works 
better. I want the 2+2 = 3 in the “Little Red School House” to play while the 2nd 
Grade Math Class slide is presenting. 
 

6. Click the Slide Sorter View icon on the Views bar to display the thumbnails. 
 

 
 

7. Drag the slides to reorganize them in the order shown below:  Remember that 
wherever you see the vertical line is where the slide will be placed. 
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Note:  You may notice that I also decided to add another copy of the Little Red 
School House graphic to the Sources slide. 
 

8.  If you rehearse the slide timings again, you can replace the previous timings. 
  

 
Print 
 

 

1. Click the  tabl on the Ribbon to enter Backstage View. 
 

2. Click . 
 

3. At Print Settings, you can Print All Slides or selected Slides: 
 

 
 

4. You can print Full Page Slides, Notes Pages, Outline, or Handouts. 
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Set Up Show  
 

Sometimes you may want to use the Slide Timings to present your slideshow 
automatially.  This is a good choice when you are not asking for audience participation 
in the presentation.  i.e. showing pictures of students at a honors banquet. 
 
If you are using the PowerPoint as a list of “talking points,” as you speak about a 
particular topic, you may want to advance through the slides manually. 
 

1. Click the tab on the Ribbon.  Click the Set Up Show icon in the Set 
Up group. 
 

 
 

2. At the Set Up Show dialog box, there are a number of options.  
 
Under Advance Slides, you may select the method to advance the slides: 
 

 
 
Under Show Options, if you are using “timings,” you may want to select “Loop 
continously until ‘Esc,’ which will play the slideshow over and over until you click 
the Escape key. 
 

 
 

Note:  A great new feature of PowerPoint 2013 is its ability for PowerPoint to 
sense your computer’s setup (if you have a presentation screen or a dual monitor) 
and choose the right monitor for Presenter View. 
   

 
Present the 
Show 
 

 

1. Click the tab on the Ribbon. 
 

2. Click From Beginning from the Start Slide Show group. 
 

 
 
OR 
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With Slide 1 open in Normal View, click the Slideshow icon in the Views Bar 
 

 
 

 
ADDITIONAL FEATURES 

 

 
Add Slides 
from Other 
PP  
Presentations 
 

 
This is useful when a grop is working on a project and each member has created some 
of the slides for the project. 
 

1. Start a new blank presentation. 
 

2. Click the tab on the Ribbon. 
 

3. Click the New Slide down arrow in the Slides group and select Reuse Slides. 
 

 
 

A  pane displays to the right of the 
workspace.  
 

4. Click the Browse down arrow and select 
Browse File… 
 
Navigate to the location of the file that contains 
the slides you want to insert. 
 
A Reuse Slides pane displays all of the slides from the selected presentation in 
Thumbnail View with the name of the slide to the right of each thumbnail. 
 
As you move your mouse over a thumbnail, it is enlarged. 
 

5. Click each of the slides you want to add to the current slideshow. 
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